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About half of the
containment losses in a
refinery, petrochemical or
chemical process plant can
be influenced by
maintenance and

inspection
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« Moisture ingress in equipment with polythionic acid

¢ Inspection damage to protective coatings or glass-lined vessels
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+ Human error
o Natural disasters
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¢ External events (eg collisions or falling objects)
¢ Secondary effects from nearby units

+ Consequential effects from associated equipment in the same unit

o Deliberate acts (eg sabotage)

Level of inspection activity
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¢ Design errors

* Fundamental limitations of inspection method

k Unknown mechanisms of deterioration
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Table 4.4 - Management Systems Evaluation
Table Title Questions Points
2.A1 Leadership and Administration 6 70
2.A2 Process Safety Information 10 80
2.A3 Process Hazard Analysis 9 100
2.A4 Management of Change 6 80
2.A5 Operating Procedures 7 80
2A6 Safe Work Practices 7 85
2AT7 Training 8 100
2.A8 Mechanical Integrity 20 120
2A9 Pre-Startup Safety Review 5 60
2.A.10 | Emergency Response 6 65
2A11 Incident Investigation 9 75
2A.12 | Contractors 5 45
2A13 [ Audits - 40
Total 101 1000

T : FEENE API 581 2008455 __hk
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Score -
pscore = Ty 100 [umt 1S %]
F . l O( —0.02- pscore+1)

MS —
10 Sm:zmgerrmx =0
F 1 Svm.’.‘ge.’m‘ nl = 50
management 01 Swmg.,,,.m = 100
DNV ).046071 xS, S
(DY) (xS S nazemens = OthET VaUlUE
Pscore DNV
Score (%) FMS management
° score
0 0 10 0
500 50 1 50
800 80 0.251189 80
1000 100 0.1 100
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Table 3.1—Suggested Component Generic Failure Frequencies

_ Component GFF As a Function of Hole Size (failures/yr) fftotal
Equipment Type -
Type Small Medium Large Rupture (failures/yr)
Compressor COMPC 8.00E-06 2.00E-05 2.00E-06 0 3.00E-05
Compressor COMPR 8.00E-06 2.00E-05 2.00E-06 6.00E-07 3.06E-05
Heat exchanger HEXSS, 8.00E-06 2.00E-05 2.00E-06 6.00E-07 3.06E-05
HEXTS
Pipe PIPE-1, 2.80E-05 0 0 2 60E-06 3.06E-05
PIPE-2
Pipe PIPE-4, 8.00E-06 2.00E-05 0 2.60E-06 3.06E-05
PIPE-6
Pipe PIPE-8, 8.00E-06 2.00E-05 2.00E-06 6.00E-07 3.06E-05
PIPE-10,
PIPE-12,
PIPE-'IG.
PIPEGT16
Pump PUMP2S, 8.00E-06 2.00E-05 2.00E-06 6.00E-07 3.06E-05
PUMPR,
PUMP1S
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Table 16.3 - Corrosion Rate Adjustment Factor for Insulation Type API 581 Method Other Methods
Mnsulation Type Adjustment Factor, F | Below Average 0.75 0.5
— - | Average 1.00 1.00
I Foamgiass 075 ‘I | Above Average 1.25 2.00
l _ Peatte | 10 J
Fiberglass 125 FCM T, /E’_ Z-’»,. ;{E‘_ )—i
Mineral Wool 125
Calcium Silicate 125
" Condition of
P = Insulation| A,
API 581 Method | Other Methods
y— Above Average .73 0.25
F INS (Lopt *j
Average 1.0 0.30
Below Average or None 1.25 1.00
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STEP 4 — Determine the time in-service, age, , since the last known inspection thickness, 7

(see Section

rde
4.55. The 1, ,, is the starting thickness with respect to wall loss associated with external corrosion. If no
measured thickness is available, set 7, =7 and age, =age. |I_ i I T ——
1& 13 | —
STEP 5 — Determine the in-service time, age, ., since the coatj | = JiB: |
(2.35) = = |
35). it =
= | L
age,,,, = Calculation Date — Coating Installation Date i//f*i e
1 I I Ta Damage Factor [51
STEP 6 — Determine coating adjustment, Coar,, , using Equations I = o i
y 024 2029 2024
I Date
If age, = age,,,, : = e
) 138 13
Comadj =0 No Coating or j§ {8 I 18
- I IS S S S S . . - - '__I:E; [:l E !
| Coat,; =min[5. age,,, | 1% & T
| 13 1 /
| Coat,; = =min[15. age,, | 1 L.
T T T
Sy NGl st 2024 2029 2034
If age, <age,_,, : .
Coat,; =0 No Coating or Poor Coating Quality (2.39)
Coat,; = min|[5. age,,,]|-min[5. age,, —age,]| Medium Coating Qualiry (2.40)
Coat,,; =min|[15. age,,,|-min[l5. age,, —age,]| High Coating Quality (2.41)

STEP 7 — Determine the in-service time, age , over which external corrosion may have occurred using

Equation (2.42).

13 DNV®© 28 JUNE 2023
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Thinning DF calculations are based on the probability of three damage states being present. The three damage
states used in Section 4.5.7 are defined as:

a) Damage State 1 — Damage is no worse than expected, or a factor of 1 applied to the expected corrosion
rate

b) Damage State 2 — Damage is somewhat worse than expected, or a factor of 2 applied to the expected
corrosion rate

c) Damage State 3 — Damage considerably worse than expected, or a factor of 4 applied to the expected
corrosion rate

O OpEE HIRN=TE1B G
o BENBEEALEBNE > 1SEME
o BEMBELERNE—S > 2EEaE
o BEEMBSHLTERNERS > iames
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Consequence Analysis Dispersion
Modeling

* The computer modeling necessary to determine consequence areas
associated with cloud dispersion (flash fires, VCEs, toxic releases)

requires specific input regarding meteorological and release conditions.

« Level 1 consequence analysis, meteorological conditions representative
of the Gulf Coast annual averages were used.

» The meteorological input assumptions were as follows:
» a) Atmospheric Temperature 70°F (21°C)

b) Relative Humidity 75%

c) Wind Speed 8 mph (12.9 km/h)

d) Stability Class D

 e) Surface Roughness Parameter 30.5 mm (1.2 inch) for typical for processing
plants

15 DNV© 28 JUNE 2023
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Effects (Fire, Explosion, Toxic)
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4 Inventory group
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Release Hole Release Hole Size Ra[ﬂg?ngIeHr:Ie ey Ho_le Giaiaes d”
Number (inch) (inch)
1 Small 0-% d, =025
2
2 Medium > % —2 d, =1 Aﬂ - ﬂ-dn
3 Large >2-6 d3 = 4
4 Rupture >6 d,=min[D. 16]
N N=N-—ITHE .
> Riz RR=(Vapor) > A2 R mE(Liquid)
8 A a =m - 2' 4 P _'P
w=la.q.p kMW g, [ 2 ]"“ >E ER W=,k -pg-A” 8 (£~ Fom)
C, RT \k+l C P,
2 (=1
C MW - g. 2»;’(] . F P Ye JEpa— 7 =
Wwo=—t = -] = BA —
4 J{ RT ](;(_1_( P ” [PJ <52 Mass .4, , =180 -min [W,. W, .|
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- HEFEIFLEE! (Continuous or Instantaneous)
i5% B8 @ Instantaneous Release

* An instantaneous or puff release is one that occurs so rapidly that
the fluid disperses as a single large cloud or pool

« 3DENENRE > 4,536 kgs (10,000 |bs)

#4538 F Continuous Release

« A continuous or plume release is one that occurs over a longer
period of time, allowing the fluid to disperse in the shape of an
elongated ellipse (depending on weather conditions)

« BFALE < Y4 inch (6.35mm)
- 3DENENRE < 4,536 kgs (10,000 Ibs)
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VCE, Flash Fire, Fireball, VCE, Flash Fire
Toxic Exposure, Jet Fire, Toxic Exposure
Safe Dispersions Safe Dispersions
Instantaneous Gas Continuous Gas
i Pool Fire, Safe i Jet Fire, Pool Fire,
Dispersion Safe Dispersion
Instantaneous Liquid Continuous Liquid
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Determlne Flammable and Explosive Consequence

- STERRFEMETE Consequence Area Equations
- SIIAEE KSR BREBRSTEHHBCHNEZEZY

o Level-1PfEHEEERZSHa  bEE - LIGTERREEmE
458 F Continuous Release

CA™ =a(rate, )b

i5% &8 % Instantaneous Release

CA™ =a(mass, )b

22 DNVO© 28 JUNE 2023

DNV



Jlinl

=1

/ D MTEEER i
- API RBI Level 1 R E=41% Consequence Analysis
Tree
Continuous-Type Release
VCE
Late Ignition
Flash Fire
Early Ignition Jet Fire
Abave AIT Jet Fire
Final State Gas
No Ignition Safe Dispersion
Pool Fire
lgnition
Jet Fire
Final State Liquid
Mo Ignition Safe Dispersion

23

Figure 3.A.3.1 — APl RBI Level 1 Consequence Analysis Event Tree
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Table 4.8 - Component Damage Flammable Consequence Equation Constants

L

Table 4.9 — Personnel Injury Flammable Consequence Equation Constants

Eluid Continuous Releases Constants Instantaneous Releases Constants Fluid Continuous Releases Constants Instantaneous Releases Constants
Auto-Ignition Not Likely Auto-lgnition Auto-Ignition Not Likely Auto-Ignition Auto-lgnition Not Likely Auto-lgnition Auto-Ignition Not Likely Auto-Ignition
(CAINL) Likely (IAINL) Likely {CAINL) Likely {IAINL) Likely
(CAIL) (IAIL) (CAIL) (IAIL)
Gas Liquid Gas Liquid Gas Liquid Gas Liquid Gas Liquid Gas Liquid Gas Liquid Gas Liquid
a | b a | b a | b a | b al|sb» |a|b |aijb|ailb al|s |aj|b |ajhb a|b |aj|b |ajlb |alflhnb a|a
Ci-Cz | 430 | 098 2800 0.95 41.0 | 067 107¢ | 0.62 C-C, |1100] 086 7450 D82 79.0 | 067 3100 | 083
CaCy |4948| 100 3136| 1.00 2796 0.72 5223|063 CaCs |1252] 100 836.7 | 1.00 57.72| 0.75 1769 | 083
G 2517 | 0.99 | 5360 | 069 |3047| 1.00 13.38| 0.73 | 149 | 0.85 | 2750 081 Cs |82.05| 100 [ 1545 | 089 [s11.0| 100 2845 | 076 | 434 | 085 | o506 | 083
CaCo | 290 [D98 |1820| 089 |3124| 1.00 |525.0| 095 [13.98| 066 | 435 | 0.78 | 2757 | 061 | 57.0 | D55 CsCs | 680|095 5180 089 [828.7| 1.00 | 1315 | 092 |2672| 0.67 | 127 | 0.78 |962.8 | 063 |224.0 | D54
CeCiz | 120 | 096 |1300| 090 |391.0| 085 |5600| 085 | 71 | 066 | 3.3 | 076 |281.0| 061 | 60 |053 CoCpp | 290 | 086 [3730| 089 |981.0| 092 | 1401 | 092 | 13.0 | 066 | 95 | 076 9880|063 | 200 | 0.54
CizCus 64.0 | 0.90 1023 | 0.92 046 | 0.88 9.2 |0.88 Ci=Cis 183.0 | 0.89 2850 | 0.90 13 | 0.88 260 | D88
Ci7-Cos 200 | 0.90 861.0| D92 011 | 0.9 56 (D9 Ci7-Cxs 570 | 0.89 2420 | 0.90 0321 0.91 16.0 | 0.91
Cas+ 1.0 | 091 5440|090 | 003 | 0.99 | 14 |08 Cos+ 330 | 0.89 1804 | 0.90 0.081 | 0.99 41 | 098
Ho 645 0992 4200 1.00 615 |0.657 1430 |0.618 Ha 165.0| 0.933 117 | 1.00 118.5 | 0.652 4193 | 0.621
Ha3 320 | 1.00 203.0| 0.89 148.0| D.63 357.0 | 0.61 HaS 52.0 | 1.00 375.0( 0.84 271.0| D63 l1253 063
HF HF
Aromatics | 17.57 | 1.087 | 103.0| 1.00 |3745| 1.055 11.46| 0.667 | 70.12 | 1.00 |512.6|0.743|701.2| 1.00 Aromatics | 64.14 | 0.983 [ 353.5 [ 0.883 | 1344 [0.937|487.7| 0.268 | 18.08 | 0.686 | 0.14 [0.935 [512.6 [0.713 | 1.404 0935
Styrene |[17.87 [1.097 [103.0 | 1.00 |374.5| 1.055 11.46 | 0.667 [ 70.12 | 1.00 | 512.6 [0.713|701.2| 1.00 Styrene |64.14|0.963 | 3535 0,883 | 1344 (0,937 | 487.7 | 0.266 | 15.08 | 0.686  0.14 | 0935 5126 [0.713 [ 1404 |0.935
CO  |0.07 1752 £9.68 | 0.667 co | 270|099 105.3 | 0.692
DEE |32.84 (1134|7374 | 1.106 | 320.7 | 1.033 | 6289 | 0.649 | 155.7 | 0.667 | 5.105 | 0.919 5.672(0.919 DEE |128.1|1.025 (9719 1.219 | 1182 | 0.997 | 2658 | 0.864 | 199.1 | 0.682 | 47.13 | 0.814 | 521.7 | 0.657 | 52.35 | 0.814
Methano! | 0.026 |0.908 | 1751 | 0.934 26.11 | 0.667 | 1.919 | 0.800 Methanol | 0.016 | 1.008 | 4484 | 0.302 37.71 | 0.688 | 6.255 | 0.871
PO 14.62 (1.114 | 1295 | 0.960 65.58 | 0667 | 3.404 | 0.669 PO 38.76 | 1.047 | 1955 | 0540 83.68 | 0.682 | 15.21 | 0.834
EEA |0.002(1.035|117.0| 1.00 8.014 | 0667 | 62.0 | 1.00 EEA 0017|0945 4431 [0.835 11.41 | 0.687 | 0.153 | 0.924
Component Damage Flammable . Personnel Injury Flammable Consequence
Consequence Equation Constants EO Equation Constants

I P',rrophcnnc] 1210 ] LVR- i ] ] 'IJ'J.U] uEg |J‘dl_U] LR -] ]l‘.!bU.'L.'] 15 ] A l ot l J.3 ] Ui ]dU'I_U] uol | b IU..‘_\DI

Pyrophoric | 290 | 0.96 | 373.0] 0.89 | 981.0| 0.92 | 1401 ] 082 | 13.0 | 066 | 95 | 0.76 |968.0| 063 | 200 | 054

24 DNVO© 28 JUNE 2023
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S EBEXHIFTE (Outage Cost)

° 1% ZIK % E/J j:E }j?, ZIK Table 4.17 — Estimated Equipment Outage
) Equipment PR—— Estimated Outage in Days, Qutage,
Type Small Medium Large Rupture
Z gff, - Outage,
i Compressor COMPC, COMPR NA 3 7 NA
Outage_, , =| = -Outage
& cmd gff. mult
HEXSS, HEXTS 2 3 3 10
ol Heat Exchanger
HEXTUBE NA NA NA NA
PIPE-1, PIPE-2 0 NA NA 1
PIPE-4 0 1 NA 2
See PIPE-6 0 1 2 3
° FE% L 1% E/J }E )5\]1 ZIK Pipe PIPE-8 0 2 2 3
PIPE-10 0 2 2 4
PIPE-12 1 3 4 4
1.242+0.585-lugm{FC$ -[10}‘*’} PIPE 16 1 3 a 5
Outace = PIPEGT16 1 2 5 -
g aﬁ
Pum PUMP2S, 0 0 0 NA
P PUMPR, PUMP1S
TANKBOTTOM 5 NA NA 50
= = s COURSE-1
1'? JEE }E\ 9& through 10 - s 3 s
KODRUM 2 3 3 10
FINFAN 0 0 2 3
FILTER 0 1 2 3
F C O f ()’ r I‘ Vessel/FinFan DRUM - 3 3 10
=(Outage, . +Outage . | prodcost| REACTOR : 6 ‘ 2
prod g and g affa P COLTOP,
COLMID, 3 4 5 21
COLBTM
Notes:
1. The outage day values |j eflect their
specific requirements
2. NA - Not applicable m¢ NI S A Refer to Part 3,
Annex 3.A Section 3.A AP|-581 EF' %jﬁ/\\%fb_n 1%

EIRFIFERE

25 DNV© 28 JUNE 2023
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« BJZAPI 581FE3MRIFEMIEZAMBRETERA
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Table 4.2—Properties of the Representative Fluids Used in Level 1 Consequence Analysis

¢
Fud | W I;-e'::::y NBP | Ambient lc;:l;ia: Ideal Gas | Ideal Gas IdeaI’Gas Ideal Gas | Ideal Gas '?T
(bl (F) | Sate | £ Constant | Constant | Constant | Constant | Constant| (°F)
4 B ( D E
CeCo | 23 | 15639 | -193 | Gas | Note! | 123 |1.150E-01|-287E-05 [-1.30E-09] NA | 1036
Ci-C. 51 | 3361 | -63 | Gas Note! | 2632 | 03188 |-1.347E-04|1466E-08] NIA 696
Cs 72| 3903 | 97 | Liquid | Note! | -3626 | 04873 | -26E-04 | 53E-08 | NA | 544
CeC; | 100 | 42702 | 210 | Liquid | Note1 | -5.146 [6.762E-01|-3.65E-04 |7.658E-08| NIA 433
CeCpp | 149 | 45823 | 364 | Liquid | Note! | -85 |1.01E+00 |-5.56E-04 |1.180E-07| N/A 406
CuCiy | 205 | 47728 | 502 | Liquid | Note1 | -117 |139E+00|-7.72E-04 [1670E-07) NA | 396
Ci-Cs | 280 | 48383 | 651 | Liquid | Note! | -224 |1.94E+00|-1.126-03 |-253E-07| N/A 396
Cs | 422 56187 | 981 | Liquid | Note! | -224 |194E+00|-1.12E03|-253E-07| NA | 39
Pyrophoric | 149 | 45823 | 364 | Liquid | Note! | -85 |101E+00|-5.56E-04 [1.180E-07) NA | Noted
Aomatic | 104 | 427 | 203 | Liquid | Note2 |B.93E+04 |2.15E+05| 7.72E+02 | 9.99E+04 | 244E+03 | 914
Styrene | 104 | 427 | 293 | Liquid | Note2 |B.93E+04 |2.15E+05 | 7.72E+02 | 9.99E+04 | 244E+03| 914
Water | 18 | 623 | 212 | Liquid | Note3 |276E+05 [-200E+03| 8125 |-141E-02| 9.37E-06 | NIA
Steam 8| 623 | 212 Gas Note2 |3.34E+04 |268E+04 | 261e+03 | B.90E+03 | 1.17E+03 | NIA
Acid/Caustic-| 18 | 623 | 212 | Liquid | Note2 |276E+05|-209E+03| 8125 |-141E-02| 9.37E-06| NAA
LP

(#REVE API 581)

27 DNV© 28 JUNE 2023
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Grouping Property Method Template
Al - PhastMC -

Available Properties Property data for Acentric Factor

3 Acentric Factor value 02 103”

B3 Acid Association Flag

) Aerosol Class Number

B3 Autcignition Temperature
EJ combustion At

EJ Combustion Ct

K Critical Pressure

EJ Critical Temperature

EJ pangerous Dose 2

EJ Dangerous Dose 3

EJ Dangerous Dose 4

) Dangerous Dose S

£ Dangerous Dose 6

) Dangerous Toxic Load Note: Units are Concen
) Dimer Coefficients

) Emissive Power Length Scale

£ Enthaipy Interpolation Range
EJEerPG 1

EJERPG 2

EJerPG 3

EJ Flammable/Toxic Flag

E3 Flash Point
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Table 4.2—Numerical Values Associated with POF and Financial-based COF Categories

Probability Category 2:b:¢ Consequence Category ¢
Category Probability Range DF Range Category Range ($)
1 P#(tIg) < 3.06E-05 D total < 1 A C4!" < 10,000
2 3.06E-05 < Pr(1.1g) < 3.06E-04 1 < Dftota1 < 10 3] 10,000 < CA}"’ < 100,000
3 3.06E-04 < Py (t,Ig) < 3.06E-03 10 < Dg.fo1q1 < 100 C 100,000 < CA}’" < 1,000,000
4 3.06E-03 < Py (t.1g) < 3.06E-02 100 < Df.451q1 < 1000 D 1,000,000 < CA}’" < 10,000,000
5 P¢(tIg) > 3.06E-02 Df.tota1 > 1000 E CAf" > 10,000,000

d

® In terms of POF, see Part 1, Section 4.1.
¢ In terms of the total DF, see Part 2, Section 3.4.2.

In terms of consequence area, see Part 3, Section 4.12.1.

* POF values are based on a gff of 3.06E-05 and an Fys of 1.0. If the suggested gff values of Part 2, Table 3.1 are used, the
probability range does not apply to AST shell course, AST bottoms and centrifugal compressors.
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Figure 4.6—Case 1: Inspection Planning when the Risk Target is Exceeded During the Plan Period
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TIPS & TRICKS - YOUR USER GUIDE

TEXT STYLES

Use the TAB-key to jump
through

levels. Click ENTER, then TAB
to switch from one level to the
next level

To go back in levels use SHIFT- o
TAB il

Alternatively, Increase and
Decrease list level can be used

Reset slide £ Reset

Click the Reset menu to reset
position, size and formatting of
the slide placeholders to their
default settings

i

SLIDES & e
LAYOUTS

Click on the menu New Slide in ~ Btsout~
the Home tab to insert a new
slide

Change layout

Click on the arrow next to
Layout

to view a dropdown menu of
possible slide layouts
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PICTURES

On slides with
pictureplaceholder, click on the
icon and choose Insert

Crop picture

1. Click Crop to change size or
focus of the picture

2. If you want to scale the
picture,

hold SHIFT-key down while
dragging the corners of the
picture

HINT: If you delete the picture
and

insert a new one, the picture may
lie in front of the text or graphic.
If this happens, select the
picture,

right-click and choose Send to
Back

J

Crop

w

HEADER &
FOOTER

Do this at the very end to apply E

the changes on all slides
Header

Click on Header and Footer in & Footer
the Insert tab (write the desired

text, click date or page number

from or to)

Click Apply to All or Apply if
only used on one slide

GRIDLINES

Click the View tab and set tick
mark next to Guides

HINT: Alt + F9 for quick view of
guides

COPY/PASTE
CONTENT

When copying old content to
your new presentation, 2 options
are available:

1. Best practice: Create a slide
in your new presentation and
copy one piece of content at a
time (e.g. copy all text from one
textbox)

2. Or copy an entire slide into
your new presentation and then
choose a fitting layout.
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